
F U N D

GETTING STARTED
USER’S GUIDE



Copyright Notification

At Cougar Mountain Software, Inc., we strive to produce high-quality software at reasonable prices. We 
can only do this, however, if our rights as developers are respected. Even though we provide excep-
tional software at low prices, we do not consent to unlicensed use of our software or documentation.
Information contained in this document represents the current view of Cougar Mountain Software on 
the issues discussed as of the date of publication. Because Cougar Mountain Software must respond 
to changing market conditions, it should not be interpreted to be a commitment on the part of Cougar 
Mountain Software, and Cougar Mountain Software cannot guarantee the accuracy of any information 
presented after the date of publication.
This documentation is for informational purposes only and is not a qualified accounting reference. 
COUGAR MOUNTAIN SOFTWARE MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AS TO THE 
INFORMATION IN THIS DOCUMENT. It is the user’s responsibility to review the latest publication 
releases from Cougar Mountain Software. The demonstration companies, organizations, products, 
people, and events depicted herein are fictitious. No association with any real company, organization, 
product, person, or event is intended or should be inferred.
Complying with all applicable copyright laws is the responsibility of the user. Without limiting the rights 
under copyright, no part of this document may be reproduced, stored in or introduced into a retrieval 
system, or transmitted in any form or by any means (electronic, mechanical, photocopying, recording, 
or otherwise), or for any purpose, without the express written permission of Cougar Mountain Software.
Cougar Mountain Software may have patents, patent applications, trademarks, copyrights, or other 
intellectual property rights covering subject matter in this document. Except as expressly provided in 
any written license agreement from Cougar Mountain Software, the furnishing of this document does 
not give you any license to these patents, trademarks, copyrights, or other intellectual property.
Recognized Trademarks. Microsoft and all Windows products are registered trademarks of Microsoft 
Corporation. QuickBooks is a trademark of Intuit Inc., registered in the United States and other coun-
tries. Other brands or products are the trademarks or registered trademarks of their respective holders 
and should be treated as such.
© 2021 Cougar Mountain Software
All Rights Reserved

UGPDF00002 032921



Table of Contents
Getting Started User’s Guide

Learning About Your Available Resources 6

Frequently Asked Questions................................................................ 7

Denali Help............................................................................................. 8
Document Conventions..........................................................................................................8

In-Program Help ......................................................................................................................9

Navigating the Help with No Internet Connection................................................................9

Navigating the Web Help ...................................................................................................... 11

Printing Help Topics ............................................................................................................. 11

User Guides ...........................................................................................................................12

Release Notes........................................................................................................................12

Customer Support............................................................................... 12
Information to Gather before You Contact Customer Support .........................................12

Contacting Customer Support.............................................................................................12

Training ................................................................................................ 13
Online Training......................................................................................................................13

Classroom Training in Boise................................................................................................13

On-Site Training at Your Business ......................................................................................13

Telephone Training ...............................................................................................................14

Training Videos .....................................................................................................................14

Getting Started: The Basics 15

Opening the Software ......................................................................... 16

Finding Your Way Around................................................................... 17
The Menu Bar ........................................................................................................................17

The Toolbar............................................................................................................................18

The Navigation Pane.............................................................................................................18

The Workflow Views..............................................................................................................19

The Information Area ............................................................................................................20

The Status Bar.......................................................................................................................21

The Command Buttons.........................................................................................................21



Table of Contents
Getting Started User’s Guide

Common Software Features............................................................... 23
Module Preferences ..............................................................................................................23

Codes .....................................................................................................................................23

Transactions..........................................................................................................................23

Transaction Batches .............................................................................................................24

Posting in Denali ...................................................................................................................25

The Lookup Feature..............................................................................................................25

Adding on the Fly..................................................................................................................28

The Auto-Fill Feature ............................................................................................................29

Working with Date Ranges...................................................................................................29

The Drill-Down Feature.........................................................................................................32

Staying in Add Mode on Save ..............................................................................................32

Working with Dates ............................................................................. 33
The Software Default Date....................................................................................................33

Integration............................................................................................ 35
Posting Integration ...............................................................................................................35

Lookup Integration................................................................................................................36

Printing in Denali................................................................................. 36
Printing Output Types...........................................................................................................36

Customizing Denali for Your Organization 38

Defining Security Options .................................................................. 39

Setting Defaults ................................................................................... 39

Tracking Custom Information ............................................................ 39

Customizing Entry Windows.............................................................. 40

Designing Denali Reports................................................................... 40

Planning and Preparation 41



Table of Contents
Getting Started User’s Guide

Planning Your Organization ............................................................... 42
Information You Will Need to Get Started ...........................................................................42

Minimum Organization Setup Requirements.................................... 42

Glossary 44

Index 53



1
Chapter

Learning About Your
Available Resources

Frequently Asked Questions

Denali Help

Customer Support

Training



7Learning About Your Available Resources
Frequently Asked Questions

Welcome to Denali by Cougar Mountain. This guide is designed to help you effectively 

use your software. This chapter covers some FAQs, conventions you’ll see when you 

use the help, additional places to look for help, and available training options.

Frequently Asked Questions
Below are the answers to some frequently asked questions. 

I’m new to Denali—where do I start?
You’re reading the help, so you’re off to a good start! This Getting Started guide has a good overview of 
how to get around in Denali and explanations of some features. 
You can access all the help PDFs from the Customer Service Center (service.cougarmtn.com). Or, you 
can access them from the Start menu when you select Denali by Cougar Mountain > Denali User 
Guides. 
You can also get personal Denali training; refer to “Training” on page 13 or contact you salesperson 
for more information about the training options available.

What are the minimum requirements for running Denali?
You can find the minimum requirements on our website (www.cougarmtn.com). 

Can I convert my CMS Professional data into Denali?
You can convert the latest version of CMS Professional to Denali. For instructions and additional details, 
refer to the Conversion guide found in the web help or on the Customer Service Center 
(service.cougarmtn.com) site. If you need assistance, please contact Customer Support. 

Can I import my data from another software into Denali?
Denali allows you to import either transaction data or informational data (i.e., customer records) from an 
external file. You can also import data and transactions from QuickBooks®. Contact Customer Support 
at (800) 390-7053 for more information.

How do I add more users?
Either with or after your initial Denali purchase, you can purchase additional user licenses. Contact 
Cougar Mountain Sales at (800) 388-3038 for more information about purchasing additional licenses.

How should I set up my organization?
We recommend you practice with the demonstration data to help determine how to set up your 
organization in a way that works best for you. You can also set up an appointment with one of our 
trainers to help you get started. Contact your Sales Representative at (800) 388-3038to discuss your 
training options. 

What hours are Customer Support Specialists available?
The hours of operation for Customer Support are located on our website (www.cougarmtn.com).

https://service.cougarmtn.com
https://www.cougarmtn.com/system-requirements-denali/
https://service.cougarmtn.com/documentation/
https://www.cougarmtn.com/supportForm.asp
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Where can I access additional information and resources?
You can find information and resources on our Customer Service Center (service.cougarmtn.com) 
website. Some information is free and some is available with an annual subscription. Contact your Sales 
Representative at (800) 388-3038 for more information.

Can I get Denali training?
Cougar Mountain provides a number of training options along with documentation and customer 
support. Visit our Training Center (service.cougarmtn.com/training). 

How can I report a problem or make a suggestion?
You have a number of options to contact us. The best way to share a suggestion for the software is to 
use our CustomerVoice site online at cougarmtn.uservoice.com. You can see other suggestions, vote 
on them, and/or add your own idea. 
If you have a comment about any documentation, please email the documentation team at 
documentation@cougarmtn.com. If you believe you have found an error in functionality within the 
software, please contact Customer Support at (800) 390-7053.

Denali Help 
Cougar Mountain Software is dedicated to providing as much help as you need to feel comfortable using 
our software. These topics describe the conventions we use in the documentation and the different 
types of help we offer.
If you don’t have all modules installed, some windows and options might be different in your software 
than what appears in the documentation.
If you have not done so already, we highly recommend you review the information in the Getting Started 
guide before you continue. 

Document Conventions
The following conventions are used throughout the documentation: 

Convention Use

Bold Titles, names, and anything in the software window will appear in bold, 
exactly as it appears. 

•Select Change Session Date from the Common Tasks 
menu.
•Click the New button.
•Enter a name in the Name box.

Italic Italics are used for text that you should enter, or text that appears in a box 
or field within a window.

•Enter Hardwood in the Description box.
•The default for this field is IN Code.

https://service.cougarmtn.com
https://service.cougarmtn.com/training/
https://cougarmtn.uservoice.com/
mailto: documentation@cougarmtn.com
https://www.cougarmtn.com/contact/
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In-Program Help
Cougar Mountain offers in-program help accessible from any Help button. If you have an Internet 
connection, the web help will automatically open and includes features such as the ability to comment 
on topics, see videos, and share information on social networking platforms. 
When you access the help, you will find we offer both procedural and window-specific help. If you want 
to know the steps to complete a task, you should access the procedural (online) help. If you want to 
know what an option or field in a window is used for, you should access the window-specific help. 

Window-Specific Help
Denali offers window-specific help that explains each field and option available in every window. When 
you work in the software, you can access help specific to an active window or tab when you click the 
Help button or press F1 on the keyboard.
In many window-specific topics, you can access related task-based help topics when you select the See 
Also button at the bottom of the topic window. You can also access the task-based help from the Table 
of Contents in the left pane of the Help window. 

Procedural Help
Procedural help gives you steps to complete a process from start to finish and general information about 
the software windows. You can access this help from the left navigation pane in the software when you 
click Resources and Tools > Access the Denali Help. You can also access the Help when you click 
the question mark on the right side of the top menu bar. If you already have the Help window open, you 
can access all the help from the Table of Contents in the left pane of the window.

Reference Help
Denali includes topics that are designed to provide additional information for your reference. For 
example, format requirements to import transactions and purchase order calculations. Most of these 
topics can be found in the Appendix in the in-program help, or at the end of the PDF user guides.

Navigating the Help with No Internet Connection
This help system only opens if you don’t have an Internet connection when you click the Help button. It 
has the same information as the web help, but is accessed from your local machine.

Uppercase Uppercase characters will be used to denote keyboard keys or hot key 
combinations. Some examples are:

•To delete an item in the detail grid, select the item and
press the DELETE key.
•To open the Enter Transaction Comments window,

press SHIFT+C.

> This character is used to separate menus, submenus, and commands. 

For example: Select Renumber / Merge Stock Items from the Inventory 
Items menu is written as: Select Inventory Items > Renumber / Merge 
Stock Items from the left navigation pane.

Convention Use
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Figure 1: Navigational points and features available in the in-program help window.

The reference numbers in the table correspond with the previous figure and are used to highlight the 
main navigational points and features.  

Reference 
Number

Option Name Description

1 Contents tab This is the Table of Contents for the Help. Click on the books to show 
the related subtopics.

2 Breadcrumbs These are links that show you where you are in the Help. The first link 
reflects the main topic and following links are subtopics. You can click 
these links to navigate backwards.

3 Hide button This hides the Table of Contents and changes to read Show, which you 
can then click to see the Table of Contents.

4 Back button Clicking this button takes you back through the previously viewed topics 
one at a time.

5 Forward button Clicking this button takes you forward through the topics you have 
moved back through using the Back button, one topic at a time.

6 Home button This button returns you to the main topic window in the Help.

7 Print button If you want to print the current help topic, click this button.

8 Website button This button opens the Cougar Mountain corporate website through your 
browser.

9 Topic window This window displays the open or active topic.

10 Sublinks The links listed are subtopics of the open topic.
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Navigating the Web Help
This help system opens when you click the Help button and you have an Internet connection. To help 
you find the information you’re looking for in the web help, we outline the different parts of the window. 
We highly recommend you use the Search feature to help you find what you’re looking for.

Figure 2: Navigational points and features available in the web help window.

Printing Help Topics
You can print out any help topic to keep for future reference. 
To print a single topic:

1 Select the Print button or right-click and select Print from the right-click menu.
2 If the Print Topics window appears, select Print the selected topic and then click OK.
3 When the Print window appears, make any desired adjustments and then click Print.

11 Email Us Your feedback on the documentation and Help systems is appreciated. 
Use this email address to send the Documentation Team your 
comments or suggestions.

Reference 
Number

Option Name Description
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User Guides
Denali includes access to PDF versions of the procedural help that you can open with Acrobat® 
Reader®. This is the same procedural help content that appears in the in-program help. To access 
these user guides, click Start > Denali by Cougar Mountain > Denali User Guides. When the 
Customer Service Center site opens, choose the guide you want to view. 

Release Notes
The Release Notes include last-minute changes and technical issues not covered in other 
documentation. You can review the Release Notes on the installation screen at the start of the 
installation process, from the Start menu, or through the web help. 
To access them from the Start menu, click Start >Denali by Cougar Mountain > Release Notes. 

Customer Support
If you come across a problem or an error message you cannot resolve, call our Customer Support 
Department. Cougar Mountain Software maintains a full-time Customer Support staff at our Boise, 
Idaho office specially trained to solve problems.
Our Customer Support staff has the expertise to answer your questions about installation and operation 
of the software. Call (800) 390-7053 to contact a Support Specialist. You can receive customer support 
over the phone from Cougar Mountain Software or you might be referred to a Cougar Mountain 
business partner in your area who can provide personalized, local support. 
Cougar Mountain Software offers support contract plans that allow you to get help when you need it. 
You can request a Customer Support Specialist to contact you through our online form or you can send 
an email to Customer Support. Visit our Customer Support Center online at: https://
www.cougarmtn.com/support-request/.
You can also visit the customer service site at https://service.cougarmtn.com to search for software 
updates you can download at your convenience. 

Information to Gather before You Contact Customer 
Support
When you contact Cougar Mountain Customer Support, please have your support number ready. This 
is typically your telephone number with the area code first. It will also be helpful to know your operating 
system, the Cougar Mountain product(s) you purchased and installed, and the version of the product. If 
you are not sure how or where to find this information, Customer Support can help.

Contacting Customer Support
Refer to the following table for options available to contact a Customer Support Specialist for answers 
to your questions. You can also use one of these options to purchase a support contract, which will 
ensure you get the help you need. 

Support Type: Contact via:

Contact a Customer Support Specialist. (800) 390-7053

https://www.cougarmtn.com/supportForm.asp
https://service.cougarmtn.com
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Training
While Denali is a comprehensive business accounting solution, the information you can get from the 
software will only be as good as the information you put in. The more you know about the software, the 
more you will be able to take advantage of its features. For this reason, we consider training to be a 
critical part of the learning process. We offer several different types of training—one or more are sure 
to meet your educational needs, time constraints, and budget. Contact Cougar Mountain at (800) 388-
3038 about your training needs.

Online Training
To ensure you get the most out of your accounting software, it is important that you understand all its 
capabilities. As part of our Software Assurance program, we include the opportunity for you to 
participate in e-learning. This educational resource is offered online through the Cougar Mountain 
Customer Service Center (CSC) website (https://service.cougarmtn.com/). Depending on the 
subscription you purchase, you can access a wealth of short presentations on the features of Denali. 
Because these presentations are online, you can view a topic whenever it is convenient for you and/or 
your employees. For more information on this resource, contact your account executive at (800) 388-
3038.

Classroom Training in Boise
We offer training classes on a regular basis at our corporate headquarters in beautiful Boise, Idaho. If 
you have a few people to train, this is a great way to learn about the software’s features and how you 
can use it to its full potential. One of the benefits of coming to our training classes is that you can hear 
from other users of the software, which can remind you of issues that are important to you. Another 
benefit is that it removes you from the day-to-day tasks at your own office and allows you to concentrate 
more fully on learning how to use the software. You can use this as a powerful tool to “train your 
trainer”—once the staff members who attended the training arrive back home, they can teach other staff 
members the aspects of the software they need to know.

On-Site Training at Your Business
If you have more than a few people to train, you might want to consider on-site training. In this scenario, 
one of our professional trainers travels to your site and works with your employees. One advantage to 
this type of training is that you can train as many people as necessary without incurring additional costs 
and you can have specific people participate for specific sessions depending on their job duties. For 
example, during the training for Purchase Order, only those associated with handling purchase orders 

Purchase a Software Assurance plan. (800) 388-3038

Email questions to a Customer Support 
Specialist.

technicalsupport@cougarmtn.com

Complete the online Call Back Request form to 
have a Customer Support Specialist contact you.

https://www.cougarmtn.com/support-
request/

Support Type: Contact via:

mailto: technicalsupport@cougarmtn.com
https://www.cougarmtn.com/support-request/
https://service.cougarmtn.com
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need to be present. This will allow for less interruption in daily productivity. Another advantage of on-
site training is that you can work with your own organization’s data and business practices while 
focusing on the specific needs of your business.

Telephone Training
Training can also be done over the telephone. Using streaming technology between your computer and 
our trainer’s computer, you and your employees can work with one of our professional trainers to focus 
on the specific parts of the software you choose. The trainer will be able to see your computer screen 
and you can work with either your own data or the demonstration data to learn how to best use the 
software for your business. This is a great solution if you have one or two modules that are new to you 
and you want thorough training without traveling to our training facility or having a trainer come to you.

Training Videos
Cougar Mountain Software also offers training videos which can help you in specific areas of the 
software. They serve as a great orientation for people new to your company and/or the software. They 
also can be a refresher for people who have already used the software, but need help in a few areas or 
are changing their job responsibilities to include things they haven’t done before.
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Opening the Software

The first obstacle with any new software is to learn the way it’s organized and where 

you can find various options and features. This basic introduction provides an 

explanation of the overall layout and takes you on a quick tour of the available features 

and functions in Denali.

Opening the Software
After you install the software according to the instructions in the installation documentation, you are 
ready to get started. 
To open the software and select an organization:

1 Select Start > All Programs > Denali by Cougar Mountain > Controller.
2 When the software first opens, the CMS Select Organization window appears. (If you only have one 

organization set up in the software, this window will not appear).
This is where you select the organization you want to work with. Double-click the organization, or after 
highlighting the line, click the Select button.

Figure 3: CMS Select Organization window

3 If more than one user is set up, the CMS Login window will appear. 
Enter the User ID and password. The default User ID is SUP and there is no default password. 

4 After you enter the login information, select OK to continue.

Tips & Tricks:  Using the Demonstration Data
Demonstration data is included in Denali and is designed to show you how the program 
works. We strongly recommend you become familiar with the demonstration data and 
use it to learn, train, and experiment. This will allow you to try out features available in 
Denali without the risk of harming your organization data.

InstallationGuide.chm::/Install_Denali.htm
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Finding Your Way Around
Denali is a modular program. Each module runs separately from the other modules, but they are 
designed with a similar layout and work together seamlessly. If you select to use Classic navigation in 
Controller Module Preferences for any modules (see the Controller guide), the module layout will look 
different; there will not be a navigation pane, workflow, or information area. The Help is written assuming 
you are not in classic view.

Figure 4: Navigating Denali

The Menu Bar
You can use the menu bar to access most of the features and functions throughout the software. Each 
module has menus and menu items specific to that module. An item that is disabled indicates it is not 
available to use. 

ControllerCS.chm::/CMS_Mod_Pref_window_General_tab.htm
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Figure 5: Accounts Receivable menu bar

Following is a list that will give you an idea of what menus you can find in Denali and what functions you 
can expect to perform using these menus. 

• File menu: This is first on the menu bar, and the same throughout all modules. It provides a way 
to access the other installed modules and Cougar Dtails. 

• A management function menu: Usually second on the menu bar. An example is the IN Stock 
menu. 

• A transaction-related menu: Usually third on the menu bar. An example is the AP Enter Bills 
menu. 

• Reports menu: Usually follows the transaction-related menu and gives you access to reporting 
options for the module you are working in. 

• Period End menu: Usually follows the Reports menu, and provides options for performing end 
of period tasks.

• Options menu: Usually follows the Period End menu, and contains module preferences. It also 
gives you access to module codes.

• Help menu: Usually the last option in the menu bar, and provides access to the Denali help.
• Custom Options menu: This menu only appears if you set up a custom menu in the CMS 

Module Preferences window.

The Toolbar
The toolbar contains buttons for easy and quick access to commonly used windows, as well as 
shortcuts to open the other installed modules, Cougar Dtails, and the Help. A module icon will only 
appear on the toolbar if you purchased the module and you have security rights to access it (see the 
Controller guide for information about security). 
Depending on the option you select in the CMS Module Preferences window (click the Help button in 
the Module Preferences window for information about the specific options in that window), clicking a 
module icon will either open a new instance or open an existing instance of that module. If no open 
instances exist, a new instance opens regardless of the Module Preference setting. Selecting the drop-
down next to a module icon gives you the option to view any already open instance(s) of a module or 
to open a new instance.

Figure 6: The toolbar 

Tooltips appear on all toolbar icons so you can see what the icons open without clicking them.

The Navigation Pane
In addition to the menu bar, the navigation pane is where you can access menu options and specific 
windows. You can vertically and horizontally resize areas within the navigation pane. When you click a 
menu button at the bottom of the pane, the window options associated with that menu appear in the 

ControllerGuide.chm::/User_and_Security_Opt.htm
ControllerCS.chm::/CMS_Mod_Pref_window_General_tab.htm


19Getting Started: The Basics
Finding Your Way Around

upper area of the pane. Double-click a window option to open the associated window where you can 
complete the listed task. Additionally, you can right-click on some options, such as UDF Codes and 
batches, to view a submenu. For example, you can right-click on a batch in the Manage Batches section 
in any module to open a submenu with options to select, edit, clear, delete, post, or create a new batch, 
depending on your user rights.

Figure 7: The navigation pane

If you click the Reporting button at the bottom of the pane, a list of available reports appears in the 
upper area. If you click a report name, you will see a sample image of the report. You can double-click 
the sample image or the report name to open the report window.

The Workflow Views
The workflow provides you with a quick way to access your most frequently used windows in each 
module. Each module displays a workflow with tasks specific to that module and each icon in the 
workflow represents a task that you often need to complete while you work in the module. At the bottom 
of the workflow view are common tasks that don’t occupy a specific place in the workflow order. Click 
an icon to open a window in which you can complete the task. 
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Figure 8: The workflow view

The Information Area
Beneath the workflow view, all installed module integration settings are listed. This helps you quickly 
see the relationships set up between the modules. When you view a sample report image, this area 
changes to show information about the selected report. 
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Figure 9: The information area

The Status Bar
At the bottom of the screen, the status bar displays the date, time, current user, and the open and active 
batch. The left side of the bar indicates the function of certain components in the software as you mouse 
over them.

Figure 10: The status bar 

The Command Buttons
Many of the Denali windows include a group of common buttons called the command buttons. These 
buttons perform the same functions in each window. Some windows have additional buttons.
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Figure 11: The command buttons 

Refer to this table for an explanation of the command buttons and their functionality in the system.  

Command Button Function / Description

Select the Save button to save any changes you make in a window.

Select the Cancel button if you do not want to save any changes you 
made and you want to close the window.

Select a record and select the Edit button if you want to make changes 
to the record.

After you select a record, clicking the Edit button will change the Edit 
button to the Del button. Select the Del button if you would like to delete 
the selected record.

Select the Clear button if you want to clear any information in the 
window but you do not want to close the window.

Select the New button if you are viewing a previously saved record and 
want to create a new one.

Select the Print button to print information relevant to the records 
displayed in the window.

Use the Find button and arrows to search for records. The Find button 
will open a Lookup for the records. Selecting the arrow buttons will 
navigate through the records one by one.
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Common Software Features
We designed our software to be intuitive and efficient. We did this in part by using common design 
throughout the software. Each module is set up so it is easier to find features that are similar across 
modules.
Modules are designed to work together seamlessly and features in the software allow you to access 
information from modules other than the one you are working in. For example, while working in one 
module, you can use the Lookup feature to view and edit information in other modules. See “The Lookup 
Feature” on page 25 for additional information. This interaction ties the modules together into a powerful 
whole that simplifies your daily tasks and increases your productivity.

Module Preferences
In each module, you will find Module Preferences under the Options menu. These preferences allow 
you to customize the way each module functions. The preferences available will vary for each module, 
but there are some similarities. For example, you can set up Print Options and User-Defined fields by 
using Module Preferences in several modules. No matter how you use the software, you will want to 
become familiar with the Module Preferences window in each module.

Codes
Codes allow you a great amount of flexibility in the software. You can use the codes in many different 
ways depending on the module. Each module allows you to create codes to direct posting and further 
customize how you want the software to work for you. 
For example, Inventory uses Inventory Codes to identify groups of stock items and apply specific 
settings to those stock items. When you create multiple Inventory Codes, you can specify the General 
Ledger accounts you want to post to for specific stock items as well as the valuation method and the 
default Sales Tax Code. You can also use Codes to sort inventory items for reports. Refer to the 
Inventory guide for more information on Defining Inventory Codes.
It is a good idea to be familiar with the codes available in all the modules you have installed so you can 
be sure you use all the associated features in Denali.

Transactions
Many of us think of accounting in terms of transactions. We pay bills, purchase items, pay employees, 
sell goods or services, and, most importantly, deposit money in the bank. More than likely, transactions 
will account for the bulk of your day-to-day interaction with the software.
For ease of access, each module includes a button in the toolbar that will directly open the transaction 
entry window. Each module handles transactions specific to that module and, depending on how you 
set up the software, these transactions can be reflected in multiple modules.

Select the Help button to open a context-sensitive help topic related to 
the open and active window or tab.

Command Button Function / Description

InventoryGuide.chm::/Defining_IN_Codes.htm
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Refer to the user’s guide for each module or the task-based help for specific information on how to enter 
transactions.

Transaction Dates
Whenever you post a transaction, a date is associated with it that cannot be changed. For this reason, 
it is important to be aware of the Denali date before you post transactions. The current date appears in 
the bar at the bottom of the Denali window.

Figure 12: Transaction date in Denali

If you need to change the default Denali date to enter transactions in a module, select the Change Local 
Transaction Date option in the module. This option is usually found on the Transaction menu. Once you 
change this date, it will become the default date. All transactions will use this date to post until you 
change it or close the module. When you close the module and reopen it, the date will default back to 
the Denali date. See “The Software Default Date” on page 33 for more information on working with 
dates in Denali.

External Transactions: Universal Bridge
In most modules, you can import transactions from external files. This is possible because of the 
Universal Bridge feature in the software. With the Universal Bridge, you can import transactions from 
external files and automatically create transactions in the system. Refer to the documentation for the 
module in which you want to use this feature for more information.

Transaction Batches
You can process transactions in separate batches to allow two or more people to efficiently enter 
information at the same time. This option can reduce the time it takes to enter transactions, as well as 
offer a solution to transactions you enter for a date different than the current date.
It is important to understand that each transaction, not just the batch, has a date and other identifying 
information associated with it. For instance, you can post 100 transactions in the same batch, and each 
one has different identifying information.
To process transactions using multi-batch mode, select the multi-batch mode check box in the 
preferences window for the appropriate module. If you elect to not use multi-batch processing, all your 
transactions for each session will be held in a single batch and processed at once.
If you use multi-batch mode in any module, the system will automatically prompt you to either set up or 
select a batch before you can enter transactions. Once you select or set up a new batch, you can see 
the batch identity on the bottom of your screen; you can use this to verify when you switch between 
batches. 

Figure 13: Batch status on the status bar

GettingStartedGuide.chm::/Changing_the_Date_for_a_Mod.htm
GettingStartedGuide.chm::/Changing_the_Date_for_a_Mod.htm
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Batch Processing Benefits
To illustrate how batch processing works, think of a file cabinet that contains a single file folder to hold 
transactions. If several people write transactions and use the same folder, they might collide with each 
other as they try to get into the folder. Each time they finish a transaction, they must return the folder to 
the cabinet for someone else to use, or they might forget to return the folder.
Finally, if one person decides to post transactions and takes the folder back to their office, progress will 
come to a standstill. This is an inefficient way to manage transactions.
A similar situation occurs if several people try to enter transactions into the same file in the system. Only 
one person can access a file at a time, so people must wait their turn to enter transactions. Also, people 
can easily forget to exit transactions they are processing when they finish. Once again, progress comes 
to a standstill.
The solution is to give each person their own folder. Then it will no longer be necessary to continue to 
return to the file cabinet and collide with each other. This is what batch processing does. Each user has 
their own files for their transactions and can enter information independently of others. Also, each 
person has a new batch each day to keep their transactions organized for efficient processing.
Even when several people use a single computer, batch processing is useful. They can all use the same 
batch, but use a different batch each day to keep the transactions organized. Even if you don’t post daily, 
we recommend you change batches daily for security reasons. Keeping several days’ transactions in 
the same batch is risky; should you experience an interruption during the posting process, you can lose 
the batch, and consequently, all the information contained in that batch. Refer to the section about 
batches in each module’s user’s guide or task-based help for specifics on setting up and changing 
batches in each module. 

Posting in Denali
As you enter transactions, they are stored in a batch. While you are in the batch, nothing is finalized and 
you can edit, delete, or add transactions without making permanent changes. Once a batch is ready, 
verify everything is correct by reviewing the edit report available in each module and then post the batch. 
When you post a batch, all the transactions are permanently recorded in the system and corrections 
can only be made when you enter adjustment transactions. A posting/audit report will show a detailed 
summary of where the amounts are posted and what accounts are affected.
Also, after you post a batch of transactions, the batch is removed from the system and you need to 
create a new one the next time you enter transactions. This helps preserve the integrity of your audit 
trail and is an incentive to carefully review transactions in each batch before you post them.

Refer to the section on posting in the user’s guide for each module and also, see “Posting Integration” 
on page 35 for how information is shared between modules during the posting process.

The Lookup Feature
The Lookup feature displays lists of information stored in the database. When you put your mouse 
pointer in a box that uses this feature, the cursor turns into a magnifying glass and underlines the name 
of the box.
The Lookup is available for a variety of records in each module. You can access the Lookup in the 
following ways:

• Press the F5 key in a box that has a Lookup.

NOTE:  It might be helpful if you have all users exit modules that are affected by posting 
before you post. This can help prevent data corruption.
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• Double-click in the box when a magnifying glass appears.
• Select Shift+F5 to open the GL Segment Lookup window. 
• (Denali Fund product only) Select Shift+F5 on the Fund designated segment, to open the GL 

Fund Number Lookup window.
When you use one of these methods to look up information, a window appears that lists all the available 
items for that field.

Figure 14: The Lookup feature

If a Lookup contains a large amount of items, the Loading Detail Records window appears that shows 
the loading status. When the items are loaded, the status window automatically closes. 
Also, if you have a very large amount of data, you might see a message at the bottom of the Lookup list 
that indicates you need to use the Contains search feature if the data you’re looking for does not appear. 
In this case, the Lookup loads the first group of records, but to save you time, does not load all the 
records. Type the data or a keyword you’re looking for in the Contains field. 
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Searching the Lookup 
If you want to quickly jump to a specific item in the Lookup, you can use the Search for or Contains 
fields to save time. Click the column head in which you want to locate information and type the initial 
one or two characters in the Search for field or type any text string in the Contains field (the Contains 
search only works with text fields). The Lookup automatically jumps to the section that contains those 
characters. 

You can click on a column heading to sort the results or swap the sort order for that column. You can 
also select the Sort By button to cycle through the columns.
If you want to set a column as the default sort in this Lookup, choose the sort column you want to see 
and select the Set as Default button. 

Figure 15: The Lookup window

In a Lookup window, you can use the PAGE UP and PAGE DOWN keys on your keyboard to scroll to 
find the item you need. Alternatively, you can use the scroll wheel on your mouse.
Searching the Lookup in Payroll and Job Cost
In Payroll and Job Cost, the Lookup window is different than the other modules. 

Tips & Tricks:  Using the Lookup
If you need to find a stock number that begins with the letters SA in the IN Available 
Inventory Lookup window, you can select the Stock Number column to activate the 
Search for Stock Number field and type those two characters in the Search box. The 
list scrolls to the first stock item that starts with SA. 
You can also use the Contains field to find a specific text string. For example, if you 
want to view all items that contain the word Aesop in the item description, click the 
Description column head and type Aesop in the Contains field. Click the magnifying 
glass to start the search. The results will filter the Lookup to only show items with Aesop 
in the description.
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Figure 16: The Payroll Lookup

You can use the filters at the top of each column to find the item you want to select. Click the Help button 
for information on how to use the filters in this window. To group items by a column name, drag the 
column to the grouping bar at the top of the window. For example, if you want to group the list by 
department, drag the word Department to the grouping bar. You can sort the information in ascending/
descending order by clicking the column name.

Adding on the Fly
The Add on the Fly feature gives you the ability to add new items, such as IN stock items, AP vendors, 
AP Codes, and GL accounts, while you enter transactions. When you open the Lookup window for an 
item, you can either select from the list displayed, add a new item by clicking the Add button, or view 
the selected item by clicking the View button. For some Lookups, you must have access rights to this 
feature.

PayrollCS.chm::/PR_Lookup_window.htm
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Figure 17: Add and View buttons in Lookup windows

The Auto-Fill Feature
The auto-fill feature helps you enter information by filling in the remaining text in a box as you type 
information already stored in a record. For example, as you type the name of an existing stock item, 
auto-fill completes the remainder. This can save you time and also ensure that you enter information 
consistently. Auto-fill is available for a variety of records including AR customer number, IN stock 
number, AP vendor number, and GL account number.
If you don’t want to use the auto-fill feature, you can turn it off by changing the system settings for your 
organization (see the Controller guide for more information).

Working with Date Ranges
The date range feature is available for several of the reports in Denali and can increase the speed of 
reporting. You can select a specific date range with the Date Range drop-down, from which you can 
choose one of the predefined ranges for the report.

ControllerCS.chm::/CMS_Co_Org_Information_window_System_Settings_tab.htm
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Figure 18: AR History Report window, Date Range option

There are several predefined date ranges available and the table in this section provides an overview 
of each one.

Date Range Option Start Date for Report End Date for Report

All The start date of the Fiscal Calendar. The current Denali date.

Today The current Denali date. The current Denali date.

This Week The date of the Sunday immediately 
preceding or equal to the current 
Denali date.

The date of the Saturday 
immediately following or equal 
to the current Denali date.

This Week to date The date of the Sunday immediately 
preceding or equal to the current 
Denali date.

The current Denali date.

This Month The first day of the month that 
contains the current Denali date.

The last day of the month that 
contains the current Denali 
date.

This Month to date The first day of the month that 
contains the current Denali date.

The current Denali date.

This Fiscal Quarter The first date of the fiscal quarter that 
contains the current Denali date.

The last date of the fiscal 
quarter that contains the 
current Denali date.

This Fiscal Quarter to 
date

The first date of the fiscal quarter that 
contains the current Denali date.

The current Denali date.

This Fiscal Year The first date of the fiscal year that 
contains the current Denali date.

The last date of the fiscal year 
that contains the current 
Denali date.

This Fiscal Year to date The first date of the fiscal year that 
contains the current Denali date.

The current Denali date.
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Yesterday The date immediately preceding the 
current Denali date.

The date immediately 
preceding the current Denali 
date.

Last Week The date of the Sunday immediately 
preceding the week that contains the 
current Denali date.

The date of the Saturday 
immediately preceding the 
week that contains the current 
Denali date.

Last Week to date The date of the Sunday immediately 
preceding the week that contains the 
current Denali date.

The current Denali date.

Last Month The first day of the month immediately 
preceding the month that contains the 
current Denali date.

The last day of the month 
immediately preceding the 
month that contains the 
current Denali date.

Last Month to date The first day of the month immediately 
preceding the month that contains the 
current Denali date.

The current Denali date.

Last Fiscal Quarter The first day of the fiscal quarter 
immediately preceding the fiscal 
quarter that contains the current 
Denali date.

The last day of the fiscal 
quarter immediately 
preceding the fiscal quarter 
that contains the current 
Denali date.

Last Fiscal Quarter to 
date

The first day of the fiscal quarter 
immediately preceding the fiscal 
quarter that contains the current 
Denali date.

The current Denali date.

Last Fiscal Year The first day of the fiscal year 
immediately preceding the fiscal year 
that contains the current Denali date.

The last day of the fiscal year 
immediately preceding the 
fiscal year that contains the 
current Denali date.

Last Fiscal Year to date The first day of the fiscal year 
immediately preceding the fiscal year 
that contains the current Denali date.

The current Denali date.

Next Week The date of the Sunday immediately 
following the week that contains the 
current Denali date.

The date of the Saturday 
immediately following the 
week that contains the current 
Denali date.

Next 4 Weeks The date of the Sunday immediately 
following the week that contains the 
current Denali date.

The date of the Saturday of 
the 4th week following the 
week that contains the current 
Denali date.

Date Range Option Start Date for Report End Date for Report
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The Drill-Down Feature
The drill-down feature is only available in certain windows, for example, the AR Customers and AP 
Vendors windows, and allows you to a drill-down to a report.

Figure 19: The drill-down feature 

When you hover the mouse pointer over the grid fields in a window, the mouse turns into a magnifying 
glass over paper to indicate when you can drill down to view report information. For example, in the AP 
Vendors window you can drill down to the Invoice to Payment Report or Payment to Invoice Report. In 
some windows, a magnifying-glass icon is located to the left of the line item that you can click to activate 
the drill-down feature. 

Staying in Add Mode on Save
If the Stay In Add Mode On Save command is activated, the window refreshes (saves and clears) after 
each entry or edit of an account, employee, customer, stock item, purchase order, sale, or vendor as 
soon as you select the Save button.
When a record is added or edited, and the Stay In Add Mode On Save function is not active, the 
information is updated but the window retains the current record. This can be helpful when you edit an 
existing record and you want to view changes without accessing the record again.

Next Month The first day of the month immediately 
following the month that contains the 
current Denali date.

The last day of the month 
immediately following the 
month that contains the 
current Denali date.

Next Fiscal Quarter The first day of the fiscal quarter 
immediately following the fiscal 
quarter that contains the current 
Denali date.

The last day of the fiscal 
quarter immediately following 
the fiscal quarter that contains 
the current Denali date.

Next Fiscal Year The first day of the fiscal year 
immediately following the fiscal year 
that contains the current Denali date.

The last day of the fiscal year 
immediately following the 
fiscal year that contains the 
current Denali date.

Date Range Option Start Date for Report End Date for Report
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To toggle the Stay In Add Mode On Save feature, in the appropriate module, select Options > Stay In 
Add Mode On Save from the menu bar. A check mark appears or disappears to indicate if the feature 
is on (checked) or off (unchecked). This function is on by default. If you turn it off and exit, it will be on 
again the next time you open the module. 

Working with Dates
An important element of any accounting system is the date. The dates of transactions and data in your 
system can drastically affect how useful and accurate your information is. You might also encounter 
situations in which you will need to enter information on a date different than the current date.
The fiscal calendar is the basis of the dates and calendar for the system and you should carefully plan 
and set it up. Although the fiscal calendar for many organizations follows the standard calendar year 
and ends with December, some organizations follow a different calendar. Based on your organization’s 
needs, you might need to set up your fiscal calendar differently than the default. Refer to the Controller 
guide for more information about setting up this feature.
You can also change the date for a module or for a single transaction. This is beneficial if transactions 
are accidentally skipped from a prior day but need to be posted as of that date.

The Software Default Date
You can set the default date in the organization by using the CMS Organization Information window 
in Controller. Refer to the Controller guide for more information about accessing this window.
You can use these options to specify if you want the software to use the Global Denali Date (the date 
you specify in Controller) or the Computer Date (the date stored in your computer). Both choices give 
the option to prompt or not to prompt each time the software opens. You can look at the status bar at 
the bottom of the Denali window at any time to see which date the software is using (see “The Status 
Bar” on page 21).
You can change the default date by setting different transaction dates in each module. This can be 
useful, for example, if you want to enter invoices that were received and paid a month ago.

Changing the Date Globally
The global Denali date (or system date) is the date that all modules use by default. This date is set each 
time you open the software. Depending on the organization settings entered in the CMS Organization 
Information window (see the Controller guide), you might be prompted with the default date and given 
the opportunity to change the default date when the software first opens.
After the software opens, you can manually change the global Denali date in Controller to use for all 
modules. If you don’t have access to the Controller module, or only want to change the date for a single 
module, see “Changing the Date for a Module” on page 34. To change the date for a single transaction, 
see “Changing the Date for a Transaction” on page 34. 
To change the Global Denali Date:

1 In Controller, select Common Tasks > Change Session Date.
2 In the Global Denali Date field, type in a new date or use the drop-down calendar to select a date.

ControllerGuide.chm::/Fiscal_Calendar.htm
GettingStartedGuide.chm::/Changing_the_Date_For_a_Tran.htm
ControllerCS.chm::/CMS_Co_Org_Information_window_System_Settings_tab.htm
ControllerCS.chm::/CMS_Co_Org_Information_window_System_Settings_tab.htm
ControllerCS.chm::/CMS_Co_Org_Information_window_System_Settings_tab.htm
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Figure 20: CMS Change Global Denali Date window

3 Select OK.
The software uses the date you specify in this window for all modules. 

Changing the Date for a Module
In some cases you might want to use a different default date for a module, but not for any other modules 
in the software. By doing this, you can quickly enter a number of transactions for a different date. The 
date will revert back to the Denali date when you close and open the module again.
To change the local (module) transaction date:

1 Open the module in which you want to specify a different date.
2 Select Change the Session Date from the transactions menu in the module. 

For example, in Accounts Payable, this would be either the Bill Tasks or Payment Tasks menu. The 
AP Change Local Transaction Date window appears.

Figure 21: AP Change Local Transaction Date window

3 In the Transaction Date date field, type a new date or select it from the drop-down calendar. 
4 Select OK.

The software will use the date you select as the default for transactions until you close the module. 
When you open the module again, the date will revert back to the global Denali date. Refer to the status 
bar at the bottom of the window to see the date a module is currently using (see “The Status Bar” on 
page 21).

Changing the Date for a Transaction
If you want to select a specific date for a transaction, you can do this in the transaction window where 
you enter the transaction. An example of this would be setting a specific date for an invoice in the Sales 
module.
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This date will only be used for the transaction it is associated with and no other transaction dates will 
be affected. This is ideal if you only have one transaction that will use a different date or if each 
transaction uses a different date.

Integration
Integration allows data to be shared between modules automatically. This means that when you post a 
transaction in one module, data is automatically posted (shared to) the other affected modules, which 
helps maintain data consistency throughout your system. You can set the level of sharing between 
modules based on your accounting needs and business practices.
Integration also connects various Lookups throughout the software. For example, when you integrate 
the Sales module to Inventory, you make it possible to open the stock item Lookup from the Sales 
module where you can select a stock item to sell. Refer to the sections on posting and Lookups for more 
information.
To better aid you as you set up your integration we developed the Integration Guide. This guide provides 
in-depth information about integration along with scenarios on how businesses can get the most out of 
Denali. You can access this guide from the Documentation section of the Customer Service Center. 
Also, refer to the integration section of each user’s guide or the task-based help for integration settings 
specific to each module.

Posting Integration
When you integrate modules, you set up the software to share information and data with other modules. 
If you turn integration on, when you post, the software will reflect information updates in other modules 
where associated accounts or items exist. If you turn integration off, the actions in one module will not 
affect the other.
You can find and set the integration options in the Module Preferences window for each module. You 
can only integrate modules that have information to share with one another. For example, you can 
integrate the Sales module to Inventory so you can update stock item quantities. You can integrate all 
modules to General Ledger so you can post to your accounts.
If you elect to integrate, the software is designed to share data between the modules. When you post a 
transaction, the information will be sent to the module(s) that have integration turned on and is 
automatically reflected throughout the software. 
Integration is always controlled on the outgoing side. For example, you can control what modules you 
want Inventory to send information to, but you will need to go to the respective modules to change the 
information other modules share and post to Inventory. So, if you decide you don’t want transactions 
you post from Accounts Payable to affect Inventory, you need to turn off the integration in Accounts 
Payable so it does not send the information to Inventory. 
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Figure 22: Posting integrated modules

Lookup Integration
Along with posting, the ability to use Lookups is affected by integration. When integrated, Lookups allow 
a user the ability to view, select, add, or edit data in integrated modules. The Lookups provide access 
to information in other modules, such as selecting a stock item to sell in Sales, or choosing an AP 
vendor in Inventory. See “The Lookup Feature” on page 25 for more information about Lookups.

Printing in Denali
There are different options for printing information you enter into Denali. This section covers some of 
the options for output, types of printing available, and printing hardware. 
To set up your printing hardware, refer to your system’s printer folder and the documentation that came 
with your printer and computer system.

Printing Output Types
Denali includes a variety of options to choose from to meet your printing needs. Module Preferences 
allow you to define default settings for posting and other reports. If you select the Edit option on the 
Print Options tab in Module Preferences, you can change the settings for each report you choose to 
print. You can select where to print the report, how many copies you want to print, and if you want the 
parameters printed at the end of the report. You can choose to print to paper, to your screen to preview, 
or even to a file.

Refer to the following information about each output type available.

Printer
If you select Printer, you can choose the number of copies to print, whether you want to print on a laser 
or dot matrix printer (for some reports), and the printer to which you want to send the report. 

NOTE:  Depending on how your print options were set up in the Module Preferences 
window, when you click OK, a message box might appear to notify you that the 
report is being processed. Do not close the window until the process is complete; 
doing so can cause problems in your system.
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You can use a laser printer to print reports, statements, or forms. You can also choose to print 
information for the tax season, such as W-2s.
We do not recommend you use a dot matrix printer with Denali because of the inability of Microsoft® to 
print to a custom paper size for NT platforms; however, this option is still available to you for certain 
forms.

Screen
If you select Screen, you will not be given the option to select a number of copies. You can use this 
option to initially view the report before you print a hard copy. The preview window also provides a 
number of printing and exporting options.
Reports in Job Cost and Payroll open in the Crystal Reports viewer. Reports in all other modules open 
in your default PDF reader. 

File
If you select File as the printing destination, you will be given a choice of formats and the ability to 
specify the file name and path. 
Depending on the type of file you choose, you will have different options for the file once it is created.

• Plain text (*.txt): The report is saved as a plain text file, which you can open and edit using many 
word processing software applications.

• Microsoft Word® (*.doc): The report is saved as an MS Word document, which you can open 
and edit using MS Word.

• Microsoft Excel® (*.xls): The report is saved as an MS Excel spreadsheet, which you can open 
and edit using MS Excel.

• Adobe Acrobat® (*.pdf): The report is saved as an Adobe Acrobat .pdf file, which you can open 
and view using Adobe Reader.

• HTML 4.0 (*.html): The report is saved in an .html format that you can open and view through 
your web browser.

• XML (*.xml): The report is saved in an .xml format that you can view with software that supports 
this format.

If you selected to print the report to a file, enter the destination path and filename for the file. If you do 
not indicate a path, the system will default to the folder in which you installed Denali. 

CSV 
This option only appears for certain reports and allows you to export your data to a spreadsheet format. 
If you have Excel® installed, the report will automatically open in Excel. 
By default, the report saves to the path you entered on the Print Options tab in Module Preferences 
or if there is no default on this tab, it saves in your Denali installation folder. You can edit this path and 
filename. If you have a large data set you want to export, you might need to set up multiple exports and 
include a smaller range of records in each one; Excel has a limitation of 65,535 records.

Receipt Printers
This option allows the user to print a record of the transaction for the customer, as well as a second 
record for the business. This type of printer is usually used for Point of Sale registers that use 2-inch or 
3-inch receipt tape.

Label Printing
You can use this option to print labels for shipping, inventory items, or customers, to name a few.



3
Chapter

Customizing Denali for Your
Organization

Defining Security Options

Setting Defaults

Tracking Custom Information

Customizing Entry Windows

Designing Denali Reports



39Customizing Denali for Your Organization
Defining Security Options

One of the benefits of Denali is its flexibility. You can customize several aspects of the 

software to meet your business and accounting needs. In this chapter, we include 

information about some of the customization options available in Denali, such as 

setting up codes for tracking specific information, defining rights for your users, 

modifying reports, and designing certain entry windows.

Defining Security Options
We implemented several options that you can use to define security in Denali. 

• global user and group rights for all modules
• specific clerk rights in Accounts Receivable
• specific buyer rights in Purchase Order
• specific salesperson rights in Sales
• global or individual user entry window layouts in Purchase Order and Sales

In the Controller module, you can set up individual users that will log into Denali and then assign them 
specific access rights to the system. You can also create groups of users and assign rights to the group 
instead of individuals (see the Controller guide). For example, if you only want your managers to be able 
to run reports, you can set up a group for them and assign the right to print reports to the group. This 
way, only those individuals you want to have access to this type of information will have it.
You can set up  in Accounts Receivable,  in Purchase Order, and  in Sales that allow you to tailor your 
security even further. For example, with Salesperson Codes, you can determine which clerks can 
accept checks over a certain amount or void sales transactions. For more information on these different 
options, refer to the user guides for each module.
Another way you can set up security in Denali is to customize the window layouts in Purchase Order 
and Sales. You can determine which fields the individual buyer/salesperson can edit or see in the entry 
window. This is another way to hide information that you do not want every user to see or have the ability 
to change. See “Customizing Entry Windows” on page 40 for more information on this level of 
customization.

Setting Defaults
In Denali, you can set up several defaults in each module. Defaults can provide security by presetting 
certain information so that your clerks do not have access to it. These defaults can also maintain 
consistency in your data. You can use Module Preferences to determine the starting invoice or purchase 
order number or whether you want to print one or two copies of each receipt. Each module has specific 
default settings and we recommend you review the Module Preferences information for each module 
that you use. 

Tracking Custom Information
Setting up your system to track specific information about your customers, vendors, or inventory is a big 
benefit of Denali.This feature is referred to as user-defined fields (UDFs). For example, in Inventory, you 
can set up UDFs to track the exact storage location for each item. You might set up three UDFs similar 

ControllerGuide.chm::/Groups_and_Group_Rights.htm
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to these: Bin, Row, Level. Then, when your employees add stock items to the system, they can also 
enter this information. Not only can this help streamline the process of stocking and pulling items in your 
warehouse, but you can also use the UDFs as a means by which to sort or filter several reports.
This is just one example of how UDFs can enhance Denali to help you with your business decisions or 
processes. UDFs are available in Accounts Payable, Accounts Receivable, Inventory, Payroll, 
Purchase Order, and Sales. Refer to the custom tracking section of each user’s guide or task-based 
help for specifics on setting up UDFs in each module. Also, refer to “Customizing Entry Windows” on 
page 40 on how you can include UDFs in your entry windows.

Customizing Entry Windows
With Denali, you can customize your purchasing and receiving windows in Purchase Order along with 
your order entry and point of sale windows in Sales. This form of customization can be used to add 
security and decrease entry time. For example, you can modify the field titles in the header and detail 
sections of the windows to match pre-printed forms.
You can also set only fields pertinent to your business needs and practices to show in the entry 
windows. The ability to hide unnecessary fields can help decrease the entry time for your clerks/buyers. 
You might also want to hide or disable fields in the entry windows so certain employees cannot see or 
edit them. 
Not only can you customize the fields and specify which fields appear and/or can be edited, you can 
also create user-defined fields for gathering specific information when you enter transactions. See 
“Tracking Custom Information” on page 39 for more information on using user-defined fields. There are 
default settings that you can define in the Module Preferences for Purchase Order and Sales that apply 
to the entry windows as well. These default settings can help decrease entry time or help maintain 
consistency in your data (see “Setting Defaults” on page 39).

Designing Denali Reports
Denali offers many reports; however, for added flexibility, the software works in conjunction with Crystal 
Reports to offer you the ability to customize the reports or create new ones. This reporting option allows 
you to tailor reports to meet your specific accounting or business needs. Not only can you modify how 
the information is presented, but you can also define what is included in each report. 
Refer to the Crystal Reports documentation for information about how to use that program. Refer to the 
reporting content in each module’s user guide or task-based help for information about running reports 
in Denali.

GettingStartedGuide.chm::/Tracking_Custom_Info.htm
GettingStartedGuide.chm::/Setting_Defaults.htm
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One of the most important steps to successfully set up Denali is to carefully plan how 

you want to set up your organization. This chapter is designed to provide assistance 

in planning your organization and in setting up the minimum requirements necessary 

before you begin working with an organization.

Planning Your Organization
Planning can be the most important part of making your accounting system effective and beneficial. 
Even if you already have an accounting system in place, it is still a good idea to review your plan, 
consider changes you might want to make, and verify that everything is in place and will meet your 
business needs.
If you are not an accountant, we highly recommend that an accounting professional be involved in the 
planning process. This section provides some guidelines and information about planning to use Denali 
as your accounting system.

Information You Will Need to Get Started
If you are creating a new organization in Denali, you need to know how your business data interacts 
with the software. You will need to know the fiscal calendar for the business and the beginning balances 
of your accounts. You can manually add or change account balances later, but you can’t post to your 
organization until the option to add beginning balances is removed from Module Preferences in General 
Ledger (if you do not have General Ledger, this will not apply).
Refer to “Minimum Organization Setup Requirements” on page 42 for information about what is 
required to begin your organization setup. This is the minimum amount of information you must enter 
before you can enter transactions and before the system has enough information to post the 
transactions.

Setting Up All at Once or As You Go
For much of the data entry setup, you can either enter your information all at once at the beginning or 
you can enter it as you go. This largely depends on your operation and preference. For example, you 
can go through your records and enter all your vendors before you begin to use the software, either 
manually or by importing them, or you could slowly add all your vendors as you enter bills.

Minimum Organization Setup Requirements
After you plan your accounting system and gather the information you need, you are ready to create 
your new organization.
There are some minimum setup requirements you need to complete before you begin to work in the 
system. If you do not meet these minimum requirements, the system will not function properly, and you 
might see errors when you attempt to post. We do not intend this as a complete reference of the 
minimum setup requirements, and you might need to perform additional setup tasks before your 
organization is prepared to meet all your accounting needs. Refer to the setup section in the user’s 
guide for each module for additional information.
In each module, there is certain information you need to enter before you can begin to use the software. 
The following list includes some of the things you need to define in each module.
Accounts Payable

GeneralLedgerCS.chm::/GL_Mod_Pref_window_General_tab.htm
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• set your default cash account or bank account 
• define your codes 

Refer to the Accounts Payable guide for information on these settings.
Accounts Receivable 

• set up your customers 
• set up your codes

Refer to the Accounts Receivable guide for information on setting up these features.
Bank Reconciliation

• set up your bank accounts 
• set up your payees 

Refer to the Bank Reconciliation guide for information on setting up these features.
General Ledger

• create your chart of accounts 
• set up any account segments you want to use
• enter any forwarding balances for your accounts

Refer to the General Ledger guide for information on setting up these features.
Inventory

• create your stock items 
• create your codes 

Refer to the Inventory guide for information on setting up these features.
Job Cost

• set up accounts in Module Preferences 
Refer to the Job Cost guide for information on setting up these features.
Payroll

• set up employees 
• set up tax codes

Refer to the Payroll guide for information on setting up these features.
Purchase Order

• set your defaults for the entry and receiving windows
• define your Buyer Codes
• define your Department Codes

Refer to the Purchase Order guide for information on setting up these features.
Sales 

• set your defaults for both Sales windows
• select your default invoice format
• define your Department and Salesperson Codes
• choose your type of invoice numbering
• set up Register Codes and Printer Codes

Refer to the user’s guides for the Sales module for information on setting up each of these items.
You might want to set up a practice organization, or use the demonstration data to test posting or 
perform other tasks to verify the software will perform the way you need and expect. This will give you 
an opportunity to be sure you have everything in place when you set up your organization.

AccountsPayableCS.chm::/AP_Mod_Pref_window_General_tab.htm
AccountsPayableGuide.chm::/Setting_Up_AP_Codes.htm
AccountsReceivableCS.chm::/AR_Cust_window.htm
AccountsReceivableGuide.chm::/Overview_of_AR_Codes.htm
BankReconciliationGuide.chm::/Wkg_with_Bank_Accts.htm
BankReconciliationGuide.chm::/Establish_Payee_Card_Files.htm
GeneralLedgerGuide.chm::/Overview_Chart_Acct.htm
GeneralLedgerGuide.chm::/Acct_Segment_Setup.htm
GeneralLedgerGuide.chm::/Ent_Fowarding_Bal.htm
InventoryGuide.chm::/Adding_IN_Stock_Item_Records.htm
InventoryGuide.chm::/Adding_IN_Codes.htm
JobCostGuide.chm::/JC_Setting_up_Default_Accts.htm
PayrollGuide.chm::/PR_Create_New_Employee.htm
PayrollGuide.chm::/PR_Tax_Codes.htm
PurchaseOrderGuide.chm::/Defining_Your_PO_Screen_Layouts.htm
PurchaseOrderGuide.chm::/Setting_Up_Your_Users.htm
PurchaseOrderGuide.chm::/Establishing_Purchasing_Departments.htm
SalesGuide.chm::/Basic_Setup_of_the_SA_Mod.htm
SalesCS.chm::/SA_OE_Pref_window_Defaults_tab.htm
SalesGuide.chm::/Setting_Up_Your_SA_Dept_SA_Dept_Codes.htm
SalesGuide.chm::/Setting_Up_Your_Salespeople_Salesperson_Codes.htm
SalesCS.chm::/SA_OE_Pref_window_Defaults_tab.htm
SalesGuide.chm::/Setting_Up_Your_Registers.htm
SalesGuide.chm::/Def_Printing_Options_Printer_Codes.htm
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Glossary

A
Accounting Period The period of time covered by an income statement. One year is often the 

accounting period for financial reporting, but financial statements are also pre-
pared by most organizations for each quarter and each month.

Accrual Basis of
Accounting

The practice of recording revenue in the period in which it is earned and recording 
expenses in the period in which they are incurred. The effect on the business is 
recognized as goods or services are rendered or consumed, rather than when 
cash is received or paid.

Applied Credit In Accounts Receivable, a credit memo that reduces the amount remaining to be 
paid on a specific debit item, instead of merely reducing the total amount owed on 
the account.

Applied Debit In Accounts Payable, a debit memo that reduces the amount remaining to be paid 
on a specific credit item, instead of merely reducing the total amount owed on the 
account.

Applied Payment In Accounts Receivable or Sales modules, a payment that reduces the amount 
remaining to be paid on a specific debit item, instead of merely reducing the total 
amount owed on the account.

AP Code A six-character alphanumeric code attached to vendor master records that directs 
how transactions are posted to General Ledger accounts and also how they are 
aged. 

AR Code A six-character alphanumeric code attached to customer master records and 
used to categorize customers. The AR Code is also used to specify a GL 
Accounts Receivable account.

Assets The economic resources owned by a business for the purpose of conducting busi-
ness operations.

Audit Trail The documentation of transactions for use by consumers and auditors of financial 
statements to substantiate the authenticity and accuracy of the financial state-
ments. Also, a report available in the General Ledger module that provides a 
chronological listing by account of the entries posted to each account.

B
Backups Periodically updated copies of computer data that ensure against total loss of data 

from a catastrophic event. Backups can be automatic or manual.

Balance Forward An AR customer type specified by the AR Code in which all open invoices are 
compacted into a single monthly balance at the end of each month. See also 
Open Item.
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Bank Reconcilia-
tion

A report, or the process of preparing it, that lists the outstanding items comprising 
the difference between the bank statement balance and the organization check-
book balance.

Batch Processing A transaction processing method that allows for multiple transactions to be 
entered and edited prior to posting. You can also choose to use one or multiple 
batches.

Batch Status The activity status associated with each batch of transactions. The status is view-
able through the Batch Status Report for modules set up for multiple batch pro-
cessing. You can access a batch until it is posted.

Batch Type Batch types are identified in the Batch Status Reports, with each type of batch 
containing different transaction types. The different modules have different batch 
types. 

Benefit Benefit earned by employee such as vacation leave, sick leave, insurance, bonus, 
etc. Benefits do not increase the amount of the employee’s paycheck.

C
CMS Date The CMS Date (or system date) is the date that all modules and software use by 

default. This date is set each time the software is opened.

Cash Basis of
Accounting

The practice of recording revenue when received in cash and recording expenses 
when they are paid in cash. 

Cash Flow State-
ment

A statement of sources of cash receipts and purpose of cash disbursements used 
to explain the change in the Cash account balance.

Cash Key An indicator that identifies a transaction as a cash transaction and determines 
which General Ledger Cash account is affected.

Chart of Accounts A list of the general ledger accounts and corresponding account numbers used to 
record the events of a business.

Committed In Inventory, the process of deducting the quantity of stock items that have been 
included in a transaction that has been saved but not posted from the available 
quantity of that stock item. Once the sales transaction has been posted, the com-
mitted quantity is subtracted from the on-hand quantity, the on-hand quantity is 
updated, and the committed quantity is reset to zero. For example, if there are 20 
widgets in stock and the clerk sells 4 over the course of the day, then the on-hand 
quantity of the item will still reflect 20, but the Available quantity (which is what 
appears when you open the stock item lookup when selling an item) will reflect 16, 
since 4 have been committed. Once the transactions for the day have been 
posted, the committed quantity is reset to zero, and the on-hand quantity is 
adjusted to 16, which will match the Available Quantity until more transactions 
which include that stock item are saved.

Consolidated Finan-
cial Statements

Financial statements presenting the combined financial position and operating 
results of affiliated organizations.



46

G
l
o
s
s
a
r
y

Glossary
Getting Started Guide

Context-Sensitive
Help

Help that is relevant to the current active window. It includes information about all 
the options in the window. A Help button is available in some windows and the 
default Help key is F1. (See also the Task-based Help definition).

Contra Account A ledger account which is deducted from a related account. 

Contra-Asset
Account

An account with a credit balance that offsets an asset account to reflect the appro-
priate balance sheet value for the asset. 

Contra-Liability
Account

An account with a debit balance that offsets a liability account to reflect the appro-
priate balance sheet value for the asset.

Cost Activity In Job Cost, you enter cost activity to keep track of the progression of your jobs. 
Activity posts to all affected modules.

Cost Code In Job Cost, Cost Codes allow you to track activity and cost for specific parts of 
your jobs. They help you maintain accurate budgets, effective planning, and stay 
up-to-date on your projects.

Credit An amount entered in the right-hand column of a ledger account. A credit 
decreases an asset or expense account balance, and increases a liability, equity, 
or income account balance.

Credit Memo A document issued that reduces the amount of a receivable or increases the 
amount of a payable. These are used to record returned goods, defective goods 
or services, miscellaneous charges or credits, and error corrections.

D
Database For Denali, the database refers to the SQL server that stores the software tables. 

The tables store all of your organization data.

Debit A debit increases an asset or expense account balance, and decreases a liability, 
equity, or income account balance.

Deduction Amount deducted from pre-tax or after-tax wages.

Default A value automatically placed in a data entry field that is saved unless it’s overrid-
den to a different value.

Department Code A Code that defines the departments within an organization. Department Codes 
determine which general ledger income accounts are affected by transactions.

Detail Line Type The type of transaction item entered on a particular line of a transaction docu-
ment.

Discount Code A two-part code established in the Sales module which specifies a discount per-
centage by inventory item and customer. One half of the code is entered on the 
customer master record and the other half is entered as part of each Inventory 
master record.
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Double-Entry
Accounting System

A system in which the total dollar amount of debits must equal the total dollar 
amount of credits.

Due From An asset account that indicates the amount of deposits held in another account.

Due To A liability account that indicates the amount payable to another account.

E
Earnings Wages, salary, or other compensation.

Edit Report A listing of entered but not posted transactions for checking the accuracy of the 
data entry work.

EFT Electronic Funds Transfer. The electronic transfer of funds from one bank account 
to another in an encrypted format. Charges are made automatically through the 
Federal Reserve’s automated Clearing House (ACH).

EFTPS Electronic Federal Tax Payment System; must be used to make electronic tax 
payments to the IRS.

EIN Employer Identification Number; This number is distributed by the IRS and is your 
business identity; also called Tax Identification Number.

Electronic Con-
stants

Method of saving data in a report format to submit the report electronically, rather 
than on paper.

Encumber Setting aside an amount as a planned expense or obligation.

Equity See Owner’s Equity.

Expense The cost of goods or services used for the purpose of generating revenue.

Expense Allocation The process of allocating indirect expenses of a business among departments.

Extended Price The result when the quantity invoiced is multiplied by the price per unit. The total 
for a detail line on an invoice.

F
FICA Federal Insurance Contributions Act. The tax paid equally by employee and 

employer, commonly known as Social Security Tax.

FIFO Also known as “first in, first out”, this is an inventory valuation method based on 
the assumption that the first item acquired is the first item sold, and that the 
remaining items are the most recently acquired.

Finished Good A product that is created by combining other items. In Inventory, this is called a 
Kit. The Finished Good has completed the manufacturing and/or assembly pro-
cess and is ready for sale.
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Form 940 Employer’s Annual Federal Unemployment (FUTA) Tax Return.

Form 941 Employer’s Quarterly Federal Tax Return.

FUTA Federal Unemployment Tax (See Form 940).

G
GL Key Six-character alphanumeric entries found in various codes throughout the 

accounting modules that are used in the Interface Table to specify an associated 
general ledger account.

H
Hold Invoice A sales invoice that is retained in the batch for further action. A hold transaction 

remains in the hold batch and does not post until it is retrieved and changed to an 
invoice.

History Transactions that were posted in any module.

I
IN Code A six-character alphanumeric code attached to IN Stock master records that 

directs how transactions are posted to General Ledger accounts and the inventory 
valuation method. 

Income Revenue resulting from the operations of a business.

Interface Code It specifies which general ledger accounts are affected by a transaction. 

Interface Key Often used interchangeably with GL Key. See GL Key.

Interface Table A cumulative table of Interface Codes that directs posting of transactions from the 
Sales and Accounts Receivable modules to the appropriate general ledger 
accounts. It is similar to a Lookup table that contains every possible set of trans-
action circumstances and the accounts affected by transactions conducted under 
each set of circumstances.

Integration Indicators set within the Module Preferences window of each module that speci-
fies communication of posted information between modules.

Invoice Only Trans-
action

A Purchase Order transaction that invoices items that were previously received 
into Inventory but not invoiced.

Invoice An itemized statement of goods or services sold that shows quantities, prices, 
total charges, payment terms, and sales tax. An invoice might also include many 
other items of information such as item description. The invoice serves as the 
original evidence of ownership transfer for both the buyer and seller.
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J
Journal Entry This is a transaction created in General Ledger that adjusts particular accounts in 

your chart of accounts.

K
Kits This refers to a method of selling a group of inventory items for one price. For 

example you could create a pizza kit that might include the dough, sauce, and 
grated cheese. A kit is a group of stock items sold together as a single item.

L
Landing Cost The costs of acquiring inventory besides the purchase cost. Sales tax and freight 

charges can be landing costs. Discounts can also be considered landing costs 
depending on your business.

Liabilities The claims against the assets of a business. The debts or financial obligations of 
a business.

LIFO Also known as “last in, first out” and is an inventory valuation method based on 
the assumption that the last item acquired is the first item sold, and that the 
remaining items are the first acquired.

Line Item Types The different types of transactions that can be documented on a detail line of an 
invoice. 

M
Master Tables The tables that hold the records containing general information about the partici-

pants or objects of transactions within a module. In General Ledger the master 
table contains the account names, numbers, and balances. In Accounts Receiv-
able the master table contains the customer names, numbers, balances, and 
other general information. In Inventory the master table contains the inventory 
item descriptions, stock numbers, and cost and quantity information.

Module One of the functional applications of Denali. The modules are Controller, General 
Ledger, Accounts Receivable, Accounts Payable, Sales (Order Entry/Point of 
Sale), Inventory, Job Cost, Payroll, Purchase Order, and Bank Reconciliation. 

N
Nested Tax Codes A set of Sales Tax Codes that are set up to charge tax on a sale for more than one 

taxing agency. The total for all agencies is assessed on the sale, and the amounts 
for the individual agencies are recorded separately.

Non-Inventory Code A code that defines product categories that are not inventory items.
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O
Open Item A line item from a receivable or payable transaction that has an amount remaining 

to be paid or applied.

Other Time In Payroll, units worked at other than the regular pay rate, such as overtime units.

Outstanding
Checks

Checks issued on a bank account that have not been presented to the bank for 
payment.

Owner’s Equity The resources invested in a business by the owner plus profits retained in the 
business. The amount by which the assets of an organization exceed liabilities.

P
Paid Out In Accounts Payable, an invoice paid to a vendor that does not have a vendor 

record established in the AP module. In Purchase Order, an order made out to a 
vendor that does not have a vendor record established in the AP module. In the 
Sales module, a paid out transaction is one in which cash is removed from the 
drawer to fund a miscellaneous purchase. 

Periodic Occurring at regular time intervals.

Phase In Job Cost, phases are groups of Cost Codes that make up different parts of your 
jobs. As you complete phases, you enter cost activity.

Posting The process of recording the effects of transactions to other integrated modules 
and General Ledger. Posting creates a history of your transactions. 

Prepaid Expenses Expenses, such as rent and insurance, which are paid in advance. The unused 
portion of prepaid expenses are a balance sheet asset.

Profit The amount by which the revenue from business operations exceeds the cost of 
operations.

R
Recurring Batch A transaction batch that holds template invoices that can be generated repeat-

edly. It is used for periodically recurring transactions without having to retype the 
information each time. 

Retained Earnings The portion of owner or stockholder equity that is a result of profit earned by the 
business.

Revenue (Operat-
ing Credit)

Income that a business receives from its business operations.

S
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SQL Structured Query Language. This is the type of database Denali uses.

Standard Cost An Inventory valuation method by which the cost assigned to an Inventory item at 
the time of sale is a predetermined estimate. When the actual cost is recognized, 
any variance between standard and actual costs is posted to an inventory vari-
ance account and an expense adjustment account.

T
Tax Number Also known as Tax Identification Number or EIN, this is the number assigned to 

your business by the IRS.

Terms Code A code in Accounts Receivable that outlines terms for early payment discounts 
and finance charges. When a Terms Code is attached to a transaction, the terms 
specified in the code apply to the transaction.

Transaction Batch A group of transactions that will be posted together.

Transactions Business events which can be measured in money.

U
Unapplied Credit A credit in Accounts Receivable or the Sales module that reduces the total 

amount owed by the customer, but does not reduce the amount remaining to be 
paid on a specific debit item. The unapplied item is an open item until the full 
amount is applied.

Unapplied Debit A debit in Accounts Payable that reduces the amount owed a vendor, but does not 
reduce the amount remaining to paid on a specific credit item. The unapplied item 
is an open item until the full amount is applied.

Unapplied Payment A payment in Accounts Receivable or the Sales module that reduces the total 
amount owed by the customer, but does not reduce the amount remaining to be 
paid on a specific debit item. The unapplied item is an open item until the full 
amount is applied.

Units The number by which the pay rate is multiplied to calculate gross pay. The most 
commonly used units in Payroll calculations are hours, but other measures of time 
or production can be used.

Universal Bridge The Denali feature that imports unposted transactions from an external file. Mod-
ules that support this feature are General Ledger, Accounts Receivable, Accounts 
Payable, Inventory, Sales, Payroll, and Bank Reconciliation.

User Interface The means by which a computer user exchanges information with the computer. 
The menu and data entry screens are good examples of user interface.

V
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Valuation Method The practice used to assign costs to inventory items sold.

W
W-2 Employee wage and tax statement, provided by the employer to the employee.

W-3 Transmittal of Wage and Tax Statements. Information filed with the Social Security 
Administration by the employer.

Weighted Average
Cost Method

This method of inventory valuation divides the total cost of stock items available to 
sell by the number of units available.

Window-Specific
Help

Help that is relevant to the current window. It includes information about all the 
options in the window. A Help button is available in some windows and the default 
Help key is F1.
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